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شناخت و به کارگیری سبک ها و مکاتب هنری در طراحی فضا   

ابزار و تجهيزات: مداد رنگی تک رنگ مانند آبی یا قرمز و مداد اتود با نوک نرم و 
خط کش و لوازم مورد احتیاج می باشد.

رئالیسم  و  کوبیسم  سبک  مانند  نقاشی  مختلف  سبک  نوع  دو  ابتدا  اول:  گام   
انتخاب شود.

واحد یادگیري    4     :  ایجاد سبک بصری  
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 گام دوم: سپس یک صحنه از یک پویانمایي که فضاسازی در آن صحنه بارزتر 
است انتخاب کنند. برای انتخاب یک صحنه از پویانمایي می توانند آن را در رایانه 
پخش کرده و با متوقف کردن آن پویانمایي از آن صحنه موردنظر عکس گرفته و 

آن را برای تمرین آماده کنند.

را  آن صحنه  انتخابی،  دو سبک  از  الهام  با  را  انتخاب شده  تصاویر   گام سوم: 
از  بیاورند. لازم است هنرجویان ویژگی های کلی  رئالیسم در  و  به سبک کوبیسم 
از  الهام  و  تغییرات صحنه  تا در  را مطالعه کنند  انتخاب می کنند  سبک هایی که 

سبک موردنظر با دقت بیشتری عمل کنند. 

پویانمایي سينمایی زوتوپيا

تصویرانتخابی از یک فيلم پویانماییتصویرانتخابی از یک سبک هنری

فضاسازی نهایی همان تصویر انتخاب شده پویانمایی با 
الهام از سبک هنری انتخاب شده
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که نکته باشد  گونه ای  به  باید  پویانمایي  در  انتخاب سبک  که  است  توضيح  به  لازم 
قابليت تکثير در دقيقه های بالا و به صورت گروهی را داشته باشد و به گونه ای 
نتوان عين آن را تکثير  برای فریم بعدی  نباشد که فقط یک فریم کار شود و 

نمود.

 گام چهارم:  از روی دو تصویر انتخابی سبک ها، هنرجویان با مداد طراحی کنند.
  گام پنجم: سپس ویژگی های این سبک را بیان کنند. مثلًا برای سبک کوبیسم 
استفاده  بیشتر  و صاف  تیز  و خطوط  از شکل های هندسی  که  بگویند  می توانند 

شده است.
  گام ششم: پس از آن یک فضا با الهام از آن سبک ها طراحی کنند. دقت کنند 
که این طراحی فضا برای استفاده در پویانمایي می باشد و باید به گونه ای از سبک 
الهام گرفته شود که از بابت بصری زیبا و در عین حال شخصیت ها در آن محیط 

گم و ناپیدا نباشند.
 گام هفتم: در گام بعدی برای بخش مکتب های هنری از هنرجویان بخواهید 
تصویری از یک مکتب هنری مانند مکتب نقاشی قهوه خانه ای تهیه نمایند سپس 

دربارة ویژگی های بارز آن مکتب، مطالبی را گردآوري کنند.
  گام هشتم: پس از آن با استفاده از مداد طراحی شروع به کپی برداری و مطالعة 
درباره  ما  کتاب  موضوع  چون  که  باشند  داشته  توجه  کنند.  نقاشی  آن  تصویری 

فضاسازی می باشد؛ مشخصات بازر تصاویر انتخابي فضاسازی و محیط باشد.
 گام نهم: پس از کپی برداری به وسیله طراحی اکنون از هنرجویان بخواهید یک 
فضای جدید با الهام از آن مکتب انتخاب شده طراحی کنند. در این بخش نیازی 

به رنگ آمیزی نیست و صرفاً طراحی کفایت می کند.
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نوع  این  تولید شده  نمونه های  از 
پویانمایي ها که تحت تأثیر مکتب 
و سبک های هنری بوده می توان 
به پویانمایي های کوتاه جشنواره ای 
مانند نمونه های تولید شده توسط 
الکساندر  به نام  روسی  هنرمند 
و  رئالیستی  سبک  به  که  پتروف 

نقاشی رنگ روغن اشاره کرد.

پيرمرد و دریا، الکساندر پتروف
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به کارگیری تکنیک های تصویرسازی در طراحی فضا  
در این بخش در کتاب اصلي هنرجویان توضیحات کافی وجود دارد و نیاز هست 

این بخش با فعالیت عملی بیشتر و بهتر قابل درک برای هنرجویان باشد.
  گام اول: ابتدا یک کتاب داستان مربوط به هر گروه سنی که در آن از تصویرگری 

استفاده شده است را انتخاب کنند.
  گام دوم: سپس دربارة ویژگی های تصویرگری کتاب و تکنیک اجرایی آن به 

همراه هنرجویان به  بحث و بررسی پرداخته شود.
 گام سوم: از آنها بخواهید از روی تصویر انتخاب شده با مداد طرحی، کپی برداری 

و طراحی کنند.

نکته آن  دیزاین  و  ساختاری  ویژگی های  طراحی  هنگام  در  هنرجویان  است  لازم 
تصویرگری را هم بيان کنند.

 گام چهارم: پس از آن هنرجویان 
با الهام از سبک تصویربرداری انتخابی 

یک فضای دلخواه طراحی کنند.
یک  بعدی  بخش  در  پنجم:      گام 
بالتازار  پرفسور  مانند  پویانمایي 
با  همراه  را  چنینی  این  مشابه  یا 
هنرجویان مورد بررسی و آنالیز قرار 

دهید.
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پویانمایی پروفسور بالتازار
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 گام دوم: پس از آن، از روی آن با کپی برداری با مداد طراحی کنند و نکات مهم 
و دریافت های خود را از فرم ها و اصول آن کاریکاتور، در کلاس بیان کنند. در پایان 
هنرجویان آن چهره را تبدیل به یک فضای پویانمایی کنند. این کار می تواند با 

اضافه کردن درخت و دیوار و سایر موارد انجام گیرد. 

 روش دوم

  گام اول: در مرحلة دوم ابتدا دو تصویر )به صورت عکس( از یک شهر بزرگ 
برای بررسی  آزاد  ابتدا به صورت  آنها  از روی  و تپه ای کوچک تهیه کنند. سپس 
بیشتر فرم و ویژگی های آن تصاویر طراحی کنند. پس از آن از هنرجویان بخواهید 
که شهر بزرگ را در روی تپه با روی هم قرار دادن و جابه جایی قرار دهد در واقع 
ما هنرجو را به سمتی وادار کردیم که با استفاده از اغراق بتواند یک شهر بزرگ را 

روی یک تپه کوچک قرار دهد.

اغراق در خلق فضا 

  روش اول

 گام اول: ابتدا هنرجویان یک تصویر از کاریکاتور چهره ای را تهیه کنند. فرقی 
نمی کند که مربوط به چه شخص یا آثار چه کسی باشد اما نکته ای که بهتر است 

مدنظر قرار دهند این است که کاریکاتوري حجمي باشد.
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یا  از پل  برای خلاقیت بیشتر هنرجو می تواند 
پله پله قرار دادن خانه ها روی هم استفاده نماید. 

ترکيب شهر و تپه
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ترکیب فضاهای دوبعدی وسه بعدی  
 گام اول: ابتدا عکس هایی از خانه یا محله تهیه کنند

 گام دوم: سپس از اینترنت یا از تصاویر آرشیوی خود تصاویری از پس زمینه های 
دوبعدی مانند تصاویر کوه یا درختان و غیره تهیه کنند.

  گام سوم: سپس در فتوشاپ و با استفاده از لایه بندی، تصویر عکس محیط را 
با تصاویر دوبعدی پویانمایی ترکیب کرده و به یک فضای جدید ترکیبی برسند.
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 در ترکیب فضاهای سه بعدی با دوبعدی شما می توانید از ترکیب فضای پویانمایی 
با فیلم رئال یا ترکیب فضای دوبعدی با پویانمایي های عروسکی و نیز ترکیب فضای 

دوبعدی با پویانمایي های سه بعدی استفاده نمایید.

 این نوع ترکيب فضاهای دوبعدی با سه بعدی به دلایل مختلفی مانند تکنيک نکته
در  صرفه جویی  دلایل  به  یا  فضاها  پردازش  مانند  فنی  دلایل  یا  شده  انتخاب 
)ترکيب  نجار  و  وروجک  پویانمایي  مانند  مثلًا  دارد.  کاربرد  و...  فضا  ساخت 
از نقاشی  با فيلم زنده( یا پویانمایي های عروسکی که در نماهای دور  دوبعدی 

برای پر کردن فضاها استفاده می گردد.

 روش سوم
از هنرجویان بخواهید از اسباب بازی های موجود در خانه خود مانند ماشین یا هر 
چیزی که می توانند و ترجیحاً اگر خانه یا ماشین و... باشد بهتر است. در محیطی 
که پس زمینه عکس سفید است عکاسی کنند. سپس فضای سفید آن را در رایانه 
پاک کرده و بعد یک تصویر پس زمینه دوبعدی مانند اتوبان، خیابان یا هر منظره ای 
که می شود هم تهیه کرده و سپس آن را در فضای پشت ماشین یا آن خانه جای 

دهند.

تأثیر سبک بصری در انتخاب نرم افزار برای اجرای فضا  
برای این بخش از هنرجویان بخواهید چند نوع فضای مختلف که در نرم افزارهای 
مختلف ایحاد شده است را گردآوری کنند و سپس دربارة نرم افزار استفاده شده 
توضیحاتی مانند ویژگی ها و کاربردهای آن بیان کنند. مثلًا یک فضای سه بعدی 
بررسی  این گونه می توان  را  مانند تری دی مکس کار شده است  نرم افزاری  با  که 

نمود: 
نرم افزار به کار رفته؛ سه بعدی به نام تری دی مکس و محصول کمپانی ... می باشد. 
امروزه در پویانمایي هایی که حرکات پیچیدة دوربین نیز مواردی مانند پروژه های 
سینمایی و ... کاربرد دارد. فضای ساخته شده در این نرم افزار قابلیت این را دارد 
که به وسیلة دوربین، چرخش کامل داشته و نیز از بافت گذاری های ایجاد رنگ و 

بافت استفاده کرد و .... 
چند نمونه از فضای تصویری نرم افزارهای مختلف مانند فتوشاپ، تری دی مکس 

و ...
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فصل سوم

اجرای رایانه ای فضای دوبعدی
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دانش افزایي   

تصاویر دیجيتال 
در صنعت عکاسی آنالوگ، تصاویر آنالوگ هستند یعنی طی یک فرایند شیمیایی بر 
روی کاغذ عکاسی ثبت می گردند و دیجیتال نیستند. این تصاویر به علت نور دادن به 
ریزدانه های )Grain( حساس به نور بر سطح کاغذ عکاسی در مرحلة ظهور عکس 
به وجود می آیند. در عکاسی دیجیتال این نقاط با پیکسل معادل سازی شده اند 
و در واقع نقطه یا Dot در فایل های دیجیتال قدری متفاوت با نقاط آنالوگ است. 
همان طور که می دانید تصاویر دیجیتال به طورکلی یا وکتور )VECTOR( هستند 
که بر مبنای معادلات ریاضی ترسیم می شوند و یا رستر)RASTER( هستند که 

ساختار پیکسلی دارند.
نقاط)Dot( در دنیای دیجیتال نمی توانند در ابعاد مختلف باشند و فقط تعدادشان 
در سطح تصویر بر مبنای یک معیار، مانند اینچ و یا سانتیمتر تعیین می گردند. 
اما در تصاویر آنالوگ به خاطر فرایند شیمیایی و حساسیت کاغذ عکاسی و فیلم 
عکاسی نقاط، اندازه های متفاوت دارند. نقاط در فایل های دیجیتال بنابر پیش فرض 
سیستم های خروجی تعریف می شوند. خروجی هایی مانند پرینترها1، پلیِت سِتر2ها 

و ایمیچ ستر3ها، پروژکشن ها و مانیتورها.

 Dot Per Inch 1ـ پرینترهای سوزنی )که معمولاً در بانک ها می بینید( خروجی تصویرشان به صورت
یا نقطه بر اینچ است. 

2ـ پلیت ستر: دستگاهی در صنعت چاپ در بخش لیتوگرافی که تصاویر دیجیتال را به صورت خطی 
Line per Inch خوانش نموده و با لیزر به شکل ترام های چاپ بر روی زینک ثبت می کنند.

3ـ ایمیج ستر: دستگاهی در صنعت چاپ که مانند پلیت ستر است اما تصاویر را به همان شکل 
بر روی تلق )فیلم لیت( ثبت می کند و سپس در دستگاهی دیگر مانند عکس آنالوگ، با فرایندی 
شیمیایی تصاویر را به صورت ترام های چاپ به روی زینک منتقل می کند. )برای آشنایی بیشتر 

اطلاعات صنعت لیتوگرافی را در اینترنت جستجو کنید(

واحد یادگیري    5     :  انتقال تصاویر، شناخت ابزار و امکانات اجرایي 
فضاي دوبعدي دیجیتال
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تصاویر می توانند به صورت نقطه )Dot(، پیکسل )Pixel(، و یا خط )Line( تعریف 
شوند. در مانیتورها صفحة LED به خاطر چیدمان شطرنجی لامپ های آن، همواره 
است  چهاروجهی1  که   Pixel پیکسل  به صورت  تصویر  و  دارد  شطرنجی  ساختار 
نمایش داده می شود. ولی هنگام نمایش آنها را متناسب با کاربرد و تعریف اولیه ای 
که برای فایل کرده ایم، نمایش می دهد. نکته کلیدی درک ساختار تصاویر در این 
است که درواقع نمایشگرها )صفحات LED( صرفاً تصاویر را به ما نشان می دهند و 
فایل ها در نرم افزار و یا ابزارهای ضبط تصاویر دیجیتال نظیر دوربین های دیجیتال 
و اسکنرها شکل می گیرند. مانیتور واسطی است تا قبل از ساخت یک فایل، با دیدن 

بر روی صفحة مانیتور نوع ساختار آن را تعیین نماییم. 

شکل  اما  می گردند  ضبط  سنسورها  روی  بر  چهاروجهی  غالب  در  امروزه  دیجیتال  تصاویر  1ـ 
چهار وجهی در حال مطالعه و بازنگری است. در آیندة نزدیک شاهد پیکسل هایی با اشکال چند 

وجهی خواهیم بود. )رجوع کنید به مطالعات در مورد CCDها و CMOSها در فضای مجازی(

انواع ساختار تصاویر دیجيتال برای سيستم های خروجی

مثال هایی برای تعيين ساختارهای تصاویر دیجيتال متناسب با دستگاه های 
خروجی

 PPI معمولاً برای دستگاه هایی که خروجی آنالوگ دارند استفاده می شود. مانند: 
پروژکشن ها،  عکاسی،  دوربین های  برای  همچنین  و  لیزری  و  رنگی  پرینترهای 

مانیتورها و تلویزیون ها
  DPI، معمولابًرای پرینترهای سوزنی استفاده می شود.

استفاده  لیتوگرافی  لیزری نظیر دستگاه های  برای خروجی های  LPI، معمولاً    
می شود.

نکته براساس  که  دراو(  کورل  نرم افزار  )مانند  نرم افزارهایی  در  وکتور  تصاویر  برای 
محاسبات ریاضی تصاویر را خلق می کنند، بایستی LPI ،DPI و یا PPI، تعریف 
نمود. البته تعيين ساختار شکل گيری تصویر در نرم افزارهای وکتور، متناسب با 

نوع استفاده از خروجی مورد نظر متفاوت است.
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جلوهای بيت مپ)Pixel(: علاوه بر ساختار خطی فایل های دیجیتال، در نرم افزار 
فتوشاپ می توانید به تصویر جلوه های خطی و یا نقطه ای داد و ظاهر آن را خطی 
نمود، در واقع وقتی روی تصاویر خطی شده با ذره بین زوم می کنید باز می بینید 
که ساختار آنها پیکسل است. این گونه جلوه ها را نباید با ساختار خطی شکل گیری 

تصاویر اشتباه گرفت.

با نکته بنابراین  است  علوم  همۀ  گستردگی  به  دیجيتال  تصاویر  از  استفاده  حوزۀ 
دو  برای  متفاوتی  کاربردهای  می توانيد  علمی  مختلف  حيطه های  در  جستجو 

دسته بندی کلی تصاویر دیجيتال یعنی )Vector( و )Raster( بيابيد.

 گام اول: ابتدا از مسیر )Mode →  Gray scale( تصویر خود را سیاه و سفید 
کنید.

گـزینه  بـاز شده  پنجرة  از   mode → Bitmap از مسیر  سپس    گـام دوم: 
Halftone screen را انتخاب کنید. 

 گام سوم: سپس از پنجرة باز شدة Halftone screen تنظیمات shape و یا 
شکلی که پیکسل های تصویر به آن شکل چیده می شوند، را روی گزینه Line قرار 
دهید. در نهایت خواهید دید تصویر شما با توجه به تعداد خط و زاویه خطوطی که 

در پنجره Halftone انتخاب کرده اید تبدیل به تصویر خطی شود.

از نکته بعد  که  است  این  تصاویر  روی  بر  خطی  جلوه های  اعمال  روش های  از  یکی 
باز نمودن تصاویر در نرم افزار مسير زیر را طی نمایيد.

تصویر اصلی                                                              تصویر خاکستری
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Halftone Screen پنجرۀ 

Halftone Screen از پنجره line تصویر بعد از اعمال حالت

  line مراحل بیت مپ کردن تصاویر افکت 
 گام اول: در پنجرة Bitmap که توضیح داده شد در بخش Method گزینه 
تصویر  یک  خاکستری های  حذف  با  که  دارد  وجود  درصد   ۵۰  threshold
سیاه و سفید آن را به سیاه و سفید خالص تبدیل می کند. threshold برای تهیه 

تصاویر سیلوئت برای پس زمینه ها مفید است.
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 گام دوم: از مسیر زیر می توان این جلوة تصویری را با کنترل بیشتری بر روی 
تصاویر رنگی اعمال نمود.

Image →  Adjustments  →  threshold

پیشنهاد می شود هنرجویان چند 
تصویر دیجیتال مانند درختان و 
باز کرده  نرم افزار  در  را  صخره ها 
آنها،  نمودن  سیلوئت  از  بعد  و 
فانتزی  فضای  یک  تلفیقشان  از 

خلق کنند.

threshold تصویر اصلی قبل از اعمال فيلتر

مقدار threshold 60 درصد

مقدار threshold  100 درصد
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کيفيت تصاویر دیجيتال
دیجیتال  تصویر  یک  کیفیت  بر  که  کتاب  متن  در  شده  مطرح  عوامل  بر  علاوه 
یا  مؤثر هستند، کیفیت و حساسیت سخت افزارهایی مانند دستگاه های اسکنر و 

دوربین های عکاسی دیجیتال، نیز در کیفیت تصویر ایجاد شده مؤثرند.

ایجاد صفحه جدید، فرمت ها و مودها  
 Art board یکی از امکانات جدید فتوشاپ گزینه CC2۰1۵ بعد از آخرین آپدیت
 Art board ابزار Move و اضافه بر آن زیر مجموعه ابزار new است. در پنجرة

tool نیز برای ویرایش آرت برُد گنجانده شده است.
و  تبدیل می کند  انجام کار  برای  بوم  به یک  را  واقع صفحة جدید  این گزینه در 

داخل  را  فایل  چندین  داشتن  امکان 
یک سند به شما می دهد. عملاً   اندازة 
ابتدا  در  ساخته اید  که  فایل جدیدی 
و  جابه جایی  با  ولی  می شود  تعیین 
یا افزودن آرت بردهای متعدد به یک 
سند، ابعاد سند اتوماتیک متناسب با 
تغییر  سند  داخل  آرت بردها  جایگاه 

می یابد.
هرگاه  سند  یک  لایه های  پنجرة  در 
یک آرت برد اضافه می شود لایه ای به 
نام آرت برد اضافه می گردد که داخل 
آن، لایه های مربوط به آن طرح وجود 

دارند. 

نکته امروزه با تنظيمات مختلف دوربين های دیجيتال می توان تصاویری با کيفيت های 
مطلوب برداشت نمود.

art board تصویر گزینه
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نکاتی در مورد آرت برد  
1  به راحتی می توان با ابزار art board tool تعداد زیاد فایل جدید ایجاد نمود و 

یا ویرایش جدید از فایل های موجود داشت.
اینکه به  ابزار آرت برد به راحتی قابل تغییرات است؛ بدون  با  ابعاد آرت بردها    2
ابتدا گزینه آرت برد آن  پنجره Image size رجوع کنید. در واقع سندی که در 

فعال می شود، ابعادش متغیر است.
قابل کپی در آرت بردهای جدید هستند. کافی است  به راحتی  لایه های سند   3

با ابزار move )جابه جایی( آن لایه را از یک آرت برد به آرت برد دیگر درک نمود.
نام  و  4  هنگامی که روی یک آرت برد در داخل یک سند راست کلیک کنید 
یکی از آرت بردها را انتخاب کنید؛ نرم افزار به صورت اتوماتیک، فول اسکرینِ )تمام 
صفحة(، آن آرت برد را نشان می دهد و با استفاده از دکمة اسپیس کی برد و راست 
کلیک شما به سرعت می توانید بین آرت بردها سوییچ کنید و در داخل هرکدام که 

خواستید اعمال دلخواه را انجام دهید.
5  به علت رنگ خاکستری فضای دسکتاپ و جدا بودن آرت بردها از همدیگر شما 
می توانید ویرایش های مختلف از یک فایل را داخل یک سند، مرور کنید و عملًا 
خاکستری دسکتاپ تفکیک آرت بردها را برعهده دارد، بنابراین می توان مثلًا چند 
نوع رنگ بندی از یک فضا را داخل چند آرت برد ولی داخل یک سند داشت و با 

هم مقایسه نمود.

دستورهای نرم افزار و کاربرد پنجره ها )لایه ها، قلم ها، پالت( 
Quick selection tool یکی از ابزار مهم برای انتخاب سریع، این ابزار است. ابزار 
انتخاب سریع، برای جدا کردن بخشی از یک تصویر از پس زمینه اش بسیار مفید 

است.
ابزار  همانند  نظر،  مورد  محیط های  روی  بر  ابـزار  درگ کـردن  بـا  است  کـافی 
magic wand tool )کمند جادویی( محیط را انتخاب نمود. مکانیزم عملکرد این 
ابزار به گونه ای است که پیکسل های هم رنگ که مرز مشخصی با پیکسل های دیگر 
دارند انتخاب می کند؛ برای همین در انتخاب رنگ های تخت که پیکسل های مشابه 

زیادی دارند این ابزار بهترین عملکرد را دارد. 
استفاده می کنیم  انتخاب سریع  ابزار  از  ابزار، هنگامی که  نوار  از گزینه های  یکی 

بين نکته خاکستری  فضای  سند،  یک  لایه ها(  نمودن  )یکی  نمودن  فلت  درصورت 
فایل  یک  صورت  به  اصلی  سند  و  می گردد  سفيد  فضای  به  تبدیل  آرت بردها 

نمایش داده می شود.
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گزینه select and mask است که بسیار کاربردی و مهم است هنگام کلیک کردن 
روی این گزینه پنجرة تنظیمات پیشرفته quick selection )ابزار انتخاب سریع( 
باز می شود که می توان با استفاده از گزینه های متفاوت در پنجره باز شده با دقت 

بیشتری یک بخش تصویر را از پس زمینه اش جدا کرد.

select and mask تصویر پنجرۀ مربوط به گزینه

فعاليت ورزش  هنگام  مدرسه  حياط  در  خود  دوستان  از  هنرجویان  می شود  پيشنهاد 
تصاویری تهيه کنند و سپس با این ابزار داخل فتوشاپ آن را از پس زمينه جدا 

کنند و در فضایی جدید مانند یک ورزشگاه مونتاژ کنند.

قلم ها  
همان طوری که می دانید با کلید میانبر B ابزار قلم فعال می شود و با راست کلیک 
می توان نوع قلم را انتخاب نمود. شکل قلمی که ما از پنجرة قلم ها انتخاب می کنیم 
به صورت نگاتیو نمایش داده می شود. یعنی اگر جایی از تصویر قلم انتخاب شده 
سفید رنگ باشد هنگام استفاده از قلم )با رنگ تیره(، اثری تیره بر روی صفحه 
قرمز  مثلًا  رنگ  یک  از  قلم   همان  رنگ  برای  هرگاه  بنابراین  می گذارد  به جای 
استفاده کنیم، همین نقطه که سفید دیده می شود اثری قرمز رنگ بر روی صفحه 

می گذارد.
بنابراین قلم هایی که در شکلشان )در پنجره انتخاب قلم (، پس زمینه تیره دارند. 

به جای تیرگی قلم)با رنگ تیره(، هیچ اثری بر روی صفحه نمی گذارد.
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در یک پس زمينه سياه رنگ یک حباب سفيد رنگ طراحی کنيد.  و سپس از فعاليت
مسيرهای زیر آن را به شکل قلم تبدیل نمایيد.

Ctrl + I یا کليد ميانبر Image → Adjustments → Invert ابتدا
Edit → Define Brush preset    سپس

این نکته پراکندگی  و  کوچکی  بزرگی،  می توانيد  قلم  پيشرفته  تنظيمات  بخش  در 
حباب ها را دست کاری نمود.

تصویر نوک قلم به شکل حبابقلم اینورت)وارونه( شده

کاربرد قلم تهيه شده )حباب( در فضاسازی
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رنگ و پالت های رنگی
در پنجرة شناور color picker گزینة color libraries وجود دارد که با کلیک 
کردن بر روی آن به کتابخانه ای گسترده از پالت های رنگی دسترسی می یابید. این 
کتابخانه در اصل شامل گزیده ای از مهم ترین کتاب های رنگ هستند که در این 
کتاب ها خانواده های مختلف رنگ های هارمونیک را کدگذاری کرده و دسته بندی 

کرده اند.

کتابخانه کتاب های رنگ

نکته می توانيد   color libraries پنجره  در   picker گزینۀ  روی  بر  کردن  کليک  با 
مجدداً به پنجرۀ اصلی و پيش فرض color picker فتوشاپ برگردید.

نکته هر رنگی را از داخل یک کتاب رنگ انتخاب نمایيد، در سمت راست آن پنجرۀ 
فایلتان  رنگی  مُد  به  توجه  با  را  رنگ  آن  دهنده  تشکيل  رنگ  تنُ های  درصد 

مشاهده خواهيد نمود. 
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جعبه ابزار و کاربرد ابزارهای ویرایش  
)Move tool( ابزار جابه جایی: با استفاده از این ابزار می توان یک لایه و یا بخشی 

از یک لایه از سند را که انتخاب شده است، داخل سند فتوشاپ جابه جا نمود.
تنظیمات   )status bar( نوار وضعیت  ابزار در بخش  این  نمودن  فعال  در هنگام 
مختلفی فعال می گردند که امکان چیدمان  و توزیع لایه ها را در سطح سند )فایل(، 

برای شما پیشرفته تر و راحت تر می کند.

تنظيمات توزیع نمودن )distribution( و چيدمان لایه ها

لایه  آن  لایه،  داخل  کردن  کلیک  با  که  می کنید  تعیین  بخش  این  در  شما   :A
جابه جا شود و یا اینکه تعدادی از لایه ها که داخل یک گروه دسته بندی شده اند، 

هنگام درک کردن جابه جا شوند.

B: با فعال کردن این گزینه ۸ نقطه در حاشیة یک لایه نمایش داده می شود. با 
استفاده از این نقاط )کنترل کننده های تغییر فرم(، و به کمک موس می توان ابعاد 
یک لایه را به صورت دستی تغییر داد و با قرار دادن موس در نقاط گوشه لایه، آن 

لایه را چرخاند.

می توان در پنجرۀ لایه ها با پایين نگه داشتن دکمه ctrl کيبرد و کليک کردن نکته
چند لایه را انتخاب نمود و سپس با کليد ميانبر Ctrl +G و یا از مسير زیر آنها 

را داخل یک گروه دسته بندی نمود. 
Layer → New →  Group from Layers
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نکته کنترل کننده ها،  این  باشند.  شده  )گروه(   Group همدیگر  با  لایه  چند  اگر   
انتهایی ترین پيکسل را در داخل گروه از چهار طرف به عنوان معيار لایه، برای 
تغيير ابعاد و یا چرخش درنظر می گيرد. پيکسل های انتهایی در هر سمت گروه، 

می تواند از لایه های مختلف داخل گروه باشد و حتماً از یک لایه نيست. 

C: اگر هنگام استفاده از ابزار جابه جایی دو لایه را انتخاب کنیم در این بخش ۶ 
با کلیک کردن بر روی  انتخاب شده، فعال می گردند که  حالت چیدمانِ دو لایة 
هر کدام از این ۶ حالت، لایه ها بر طبق حالت انتخاب شده چیده می شوند. برای 
مثال اگر حالت چیدمان نمودن لایه ها را با توجه به لبة بالایی لایه ها قرار دهیم، 

دو لایه مذکور با توجه به انتهایی ترین پیکسل لبة بالایی لایه ها چیده می شوند.

D: با انتخاب نمودن بیش از 2 لایه برای توزیع و یا مرتب نمودن، ۶ حالت دیگر 
در نوار ابزار، فعال می گردند که برای Distribute یا توزیع و پخش کردن لایه ها 

در صفحه به کار می روند.

نکته به این چيدن Align کردن و یا بر طبق یک خط خاص مرتب کردن گفته می شود. 
این خط فرضی همواره موازی یکی از محورهای مختصات است حتی اگر لایه 

مورب باشد.

نکته این پخش کردن می تواند در دو حالت افقی و عمودی باشد که هر کدام از این 
دو حالت با توجه به لبه های )بالا، پایين، چپ، راست و وسط( لایه های انتخاب 

شده انجام می گرد. 

E: با فعال نمودن این گزینه Auto – Align layers  پنجره ای باز می شود که 
کاربردهای  و  است  مختلف  لایه های  در  تصویر  چند  چیدمان  مهم  پنجره های  از 

مختلفی دارد؛ نظیر:
کلاژ  به صورت  مجزا  عکس  چند  قالب  در  که  فضا  یک  مختلف  بخش های  الف( 

عکاسی شده باشند.
ب( تصاویری که به صورت مدور از دور یک استوانه نظیر یک ستون عکاسی شده 

باشند.
قالب چند  یا گود در  ج( بخش های مختلف یک فضا که داخل یک سطح مقعر 

عکس، عکاسی شده باشند.
د( بخش های مختلف یک فضا که به علت بزرگی با جابه جایی دوربین عکاسی، در 

قالب چند  عکس تهیه شده باشند.
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F: در این بخش از نوار وضعیت هنگام استفاده از ابزار جابه جایی )move( می توان 
تنظیمات یک فایل 3d نظیر فایل های 3dmax که داخل فتوشاپ باز شده است 

را دست کاری نمود.

 تمامی لایه هایی که شامل عکس های مختلف از یک فضا هستند. در این بخش 
به  بدهند، مشروط  را  واحد  تصویر  تشکيل یک  که  می شوند  گونه ای چيده  به 
اینکه در هر کدام از عکس هایی که از سطوح و یا اشيا کنار هم عکاسی شده اند، 

بخش مشترک )پيکسل های مشترک( وجود داشته باشد.

نکته

اسکن  هم  کنار  دیجيتال  تصویر  چند  قالب  در  نيز  را  بزرگ  تصاویر  می توان   
نمود و با این ابزار کنار هم چيد و یک تصویر واحد به دست آورد. با توجه به 
رزولوشن بالای اسکنرها این امکان می تواند برای تهيه تصاویر یک تکه )واحد( 

با رزولوشن بالا بسيار مفيد است.

نکته

 lens می توان با انتخاب گزینه های ،)Auto align layers( در تنظيمات این پنجره
از جابه جایی  که حاصل  آمده در حين عکاسی  به وجود  اعوجاج   ،correction

دوربين و لنز است را اصلاح نمود.

نکته

پانوراما فعاليت به صورت  فریم  چند  در  مسجد  یا  بازارچه  نظير  سنتی  فضای  یک  از   
عکاسی نمایيد و سپس با استفاده از پنجره Auto – Align layers آنها را کنار 

هم چيده و یک فضای واحد تهيه نمایيد.

ابزار محو کردن )Blur tool(: با استفاده از این ابزار و زیر مجموعه اش می توان 
بخشی از یک تصویر را تا حدودی محو یا واضح نمود. 

امکانات  فيلتر،  منوی  داخل   blur مجموعه  فيلترهای  از  می توان  ابزار  این  از 
گسترده تری برای محوکردن یک تصویر و یا بخشی از آن تصویر استفاده نمود.

نکته

ابزار روشن کردن)Dodge tool(: با استفاده از این ابزار می توان بخشی از یک 
عکاسی  در  کاغذ  روی  به  نگاتیو  کپی کردن  مرحله  در  نوردهی  )مانند  را  تصویر 

آنالوگ(، روشن تر نمود.
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ابزار سوزاندن)Burn tool(: از زیر مجموعه ابزار Dodge، می توان از این ابزار 
برای ایجاد سایه و تیرگی در طراحی فضا استفاده نمود. به این صورت که با کلیک و 
یا درگ کردن برروی تنُ های رنگی و تیرگی و روشنی های تصویر، مناطق دلخواهی 

از تصویر را تیره تر نمود. 

فعاليت Dodge tool و  ابزارهای  با  نورپردازی  پيشنهاد می شود مراحل سایه پردازی و 
Burn tool را با هنرجویان تمرین نمایيد.

لایۀ رنگ تخت در زیر لایۀ اصلی 

طراحی اوليه ربات
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 حالا می توانید با ابزار Dodge tool و کشیدن موس بر روی تصویر قبل که با 
Burn tool ایجاد کرده اید، نورها و درخشندگی لازم را به تصویر اضافه نمایید.

Dodge tool ایجاد روشنایی و درخشش توسط

  ابتدا یک لایة رنگ تخت زیر لایه خطی طرحتان ایجاد نمایید. مانند تصاویر بالا
  حالتِ لایة طراحی اولیه را از normal به multiply تغییر دهید. ) از گزینه های 

پنجرة لایه ها(
 سپس نقاط تیرة تصویر را با ابزار Burn tool با کشیدن موس بر روی لایه ای که حاوی 

رنگ تخت  است مشخص نمایید. مانند تصویر زیر:

Burn tool ایجاد تيرگی ها با سوزاندن تصویر توسط
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واحد یادگیري    6     : اجرای فضای دوبعدی دیجیتال  

قلم نوری   

اگرچه برای اجرای کارهای هنرجویی و تولیدات شخصی قطع متوسط قلم نوری 
به علت راحتی حمل و نقل، قطع بسیار مناسبی است، اما درصورتی که هزینة تهیة 
قطع بزرگ آن مهیا باشد، اندازة بزرگ به علت فضای گسترده تری که برای طراحی 

به ما می دهد مفیدتر خواهد بود.
بهترین نوع آن سینتیک کامپنیون )Cintiq Companion( است که شامل یک 
سیستم کامل به همراه سیستم عامل، مانیتور )صفحة تاچ( و قلم نوری است. که 
بر روی صفحة  نقاشی  بوم  بر روی یک  همانند کار  از آن دقیقاً  با استفاده  طراح 

مانیتور کار می کند و نیاز به رایانه در کنار تبلت و قلم نوری خود ندارد.
از مزایای آن دقت و کیفیت آن است و همچنین اینکه فضا یا شخصیت خلق شده 
مستقیماً زیر دست شماست بنابراین تمرکز و راحتی بیشتری در اجرای آن دارید 

اما از ایرادات آن گرانی قیمت و همچنین دشواری جابه جایی آن می باشد.

)Cintiq Companion( سينتيک کامپنيون

نکته  اغلب استودیودهای مجهز توليد پویانمایي به علت متغير نبودن مکان توليدشان 
در کامپنيون به جای قلم نوری های ساده تر و بدون lcd استفاده می کنند. 
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رنگ آمیزی، ایجاد سطوح تخت، بافت و سایه  
رنگ های سمبوليستی در پویانمایي

برای اینکه بر روی وجهه سمبولیستی یک رنگ تأکید شود مابقی رنگ های فضا 
معمولاً با خلوص پایین، مات  تر و یا محوتر و کم رنگ تر به کار می روند در این گونه 
فضاها معمولاً رنگ های سمبولیستی خالص هستند و اغلب در فضاهایی با پس زمینه 

تیره به کار می روند برای اینکه با فضا کنتراست داشته باشند و بهتر دیده شوند.

سمبول  رنگ ها  نيز  گاهی 
با  اما  نيستند  نشانه  و 
در  آن  فراوان  تأکيدات 
یک  به  تبدیل  فيلم،  یک 
تماشاچی  ذهن  در  نشانه 
می توان  بنابراین  می گردند. 

سمبل سازی هم انجام داد.

نکته

کاربرد سمبوليستی رنگ در فيلم
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رنگ های اکسپرسیونیستی در پویانمایي  
خصوصیات  با  بودن  درگیر  به علت  فیلم  ژانرهای  اغلب  گفت  می توان  به جرأت 

روحی و روانی شخصیت هایشان، رگه هایی از اکسپرسیونیسم دارند. 
برتون  تیم  فیلم های  نمود.  اشاره  سورئالیستی  فیلم های  به  می توان  جمله  آن  از 
به صورت اکسپرسیونیستی  )فراواقعی( هستند که  فیلم های سورئالیستی  واقع  در 

فضاسازی شده اند.
و  امپرسیونیستی  اکسپرسیونیستی،  کاربردهای  از  ترکیبی  فیلم ها  اغلب  در 
و  می گیرد  قرار  استفاده  مورد  این سبک ها،  از  یکی  اولویت  با  رنگ  سمبولیستی 

سبکی که در اولویت است؛ گرایش کلی رنگ فیلم را تعیین می کند.

کاربرد اکسپرسيونيستی رنگ در فيلم
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رنگ های امپرسیونیستی در پویانمایي  
لی اوت این گونه آثار که اغلب برای کودکان ساخته می شود، دشوارتر از بقیه سبک ها 
است زیرا علاوه بر شخصیت ها، پس زمینه و فضا نیز با رنگ های شاد   و   مفرح طراحی 
می شوند؛ بنابراین تعدد رنگ در صحنه باعث دشواری لی اوت می گردد. برای همین 
بایستی از نکات اساسی لی اوت که مربوط به رنگ نیستند برای حل نمودن این 

مشکل استفاده نمود. 

کاربرد امپرسيونيستی رنگ در فيلم

 افراط در کاربرد سبکی رنگ باعث صدمه به فيلم می گردد؛ آن چنان که سبک 
بر  مخربی  تأثير  که  می دهد  جهت  تغيير  زیر  گرایش های  سمت  به  آن  بصری 

جذابيت فيلم  نزد تماشاچيان دارد.

نکته

 کاربرد افراطی اکسپرسیونیستی رنگ، باعث سانتی مانتالیسم می گردد که نوعی 
مفهوم کلاس  اصطلاح،  این  عامیانه  کاربرد  در  است.  افراطی  مُدگرایی  و  پزُ دادن 

گذاشتن و فخرفروشی را نهفته است.
  امپرسیونیسم افراطی باعث ناتورالیستی شدن رنگ ها می شود که طبیعت گرایی 
افراطی در کاربرد رنگ است. آن چنان که تماشاچی با غرق شدن در زیبای افراطی 

رنگ از دنبال نمودن روایت  فیلم دور می افتد.
  سمبولیسم افراطی نیز باعث دکوراتیو و یا تزیینی شدن رنگ ها می شود که بیش 

از اندازه از سمبل دور می شود و دیگر نمی تواند به عنوان یک نشانه به کار رود.
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رنگ آمیزی همراه بافت و سایه 
 روش اول: سایه را به صورت یک لایه  می توان با ابزار قلم و یک رنگ تیره در 
لایه ای جداگانه ترسیم نمود. در این روش طراح بایستی تجربة زیادی در نورپردازی 

و سایه پردازی تصاویر با دست داشته باشد.
 روش دوم: روش دیگر برای ایجاد سایة اشکال بر روی سطوح دیگر این است که 
از لایة شکل یک کپی گرفت و آن را به یک لایة سیلوئت تبدیل کرد سپس غلظت 

)opacity( آن لایه را کم کرد.

کاربرد امپرسيونيستی رنگ در فيلم

در صورتی که کارگردان قصد القای سانتی مانتاليسم، ناتوراليسم و یا تزیين در 
اثرش را داشته باشد به عمد از رنگ ها به صورت افراطی استفاده می کند.

نکته

روش تبدیل یک لایه به سيلوئت )سایه( از مسير زیر است:
)Ctrl+L کليد ميانبر( Image → Adjustments → Levels

نکته

یا   High Light Output Level مقدار   ،Levels شده  باز  پنجرة  از  سپس 
درخشندگی خروجی را بر روی صفر قرار دهید. این مقدار در سمت راست پایین 

پنجره به صورت پیش فرض بر روی 2۵۵ قرار دارد.
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اکنون با یکی از فیلترهای گروه Blur اندکی لایة سایه را محو می کنیم و در نهایت 
با ترانسفورم نمودن لایة مذکور که به صورت یک لایة سایه درآمده است، آن را 

متناسب با جهت تابش نور تغییر جهت دهید.

بافت دهی به یک لایه  
می توان علاوه بر روش های مطرح شده در کتاب نظیر بلندینگ لایة بافت بر روی 
لایة زیری )تصویر( و یا استفاده از فیلترها، لایة بافت را مستقیماً در نرم افزار با ابزار 

قلم به وجود آورد.

ایجاد سایه با لایۀ سيلوئت

هنگام انتخاب قلم برای طراحی بافت می توان Mode آن را از نوار وضعيت بالای 
بافت های متنوعی  به حالت های دیگر تغيير داد و   Normal از حالت  دسکتاپ 

طراحی نمود.

نکته

 تنظيمات پيش رفتۀ قلم در پنجرۀ مطرح شده در کتاب درسی که با f5 فعال 
می شود به شما این امکان را می دهد که قلم را نيز بافت دار نمود و از این طریق 

بافت ایجاد نمود.

نکته


